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Introduction 
 
 A process flowsheet describes the 
sequence of unit operations that are 
performed in a coal preparation plant.  The 
flowsheet (or any part of the flowsheet) can 
be represented using a series of nodes and 
streams.  A node represents a unit 
operation as either a junction (two streams 
which combine to form a single stream) or 
separator (one stream that is separated in 
two streams).  A series of material balance 
expressions can be constructed for each 
node in the flowsheet.  For example, 
consider the following expressions for a 
simple separator: 
 

F = C + T 
Ff = Cc + Tt 

 
where F, C and T are the respective mass 
flow rates of the feed, concentrate and 
tailings streams and f, c and t are the 
respective assays which represent the 
content of a given component in these 
streams.  Using these balances, an 
expression for concentrate yield (Y) can be 
derived as: 

 
Y = 100 (C/F) = 100(t-f)/(t-c) 

 
This expression is known as the two-
product formula.  Using this formula, the 
mass flow rates of the concentrate (C) and 
tailings (T) streams can be calculated 
provided that the feed stream mass flow (F) 
and all assays (f, c and t) are known. 
 

 A common problem in using the two-
product formula is that a unit operation (or 
combined group of operations) is often 
overdefined, i.e., multiple sets of assays are 
available which can be independently used 
to calculate the yield.  For example, 
common assay values for coal include ash, 
sulfur, Btu/lb, etc.  As with most 
experimental programs, there is some 
degree of error associated with the data 
collection procedures.  Thus, the 
experimental assays will often provide 
different estimates of the flow rates. 

 
 Two solutions are possible to resolve 
this ambiguity.  One would be to ignore 
some of the measured data.  The second 
would be to adjust the measured assays to 
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create a new consistent data set that 
satisfies all the mass balance equations.  
The latter is obviously the more desirable 
approach.  Adjustment of the mass balance 
data must meet two criteria:  (i) all mass 
balance equations must be satisfied and (ii) 
the total adjustment made to the data set 
must be a minimum. 
 
 Numerical methods that can be used to 
solve the material balance problem include 
Lagrangian Multipliers (Wiegel) and Direct 
Search Techniques (Mular).  Computer 
packages that use the numerical methods 
include:  MBS (Hockings, 1967, Michigan 
Tech), MATBAL (Weigel, 1970, 
International Minerals Corporation), 
MATBAL2 (Laguitton, 1979, CANMET), 
ONEBAL (Wiegel, 1979) and BILMAT 
(Hodouin, 1980).  A material balance 
program has also been developed at 
Virginia Tech using a commercial 
spreadsheet package. This package is 
capable of handling up to 10 nodes, 20 
streams and 5 assays.  This spreadsheet 
program is known as TECHBAL. 
 
Procedure for Using Techbal 
 
Step I – Load Software 
 
1. Make sure that Microsoft Excel (95 or 

later) is loaded on your computer. 
 
2. Run Excel and determine whether the 

“Solver Add-In” is has been loaded.  
This option should be listed under the 
Tools menu in Excel. If you do not 
see Solver under this menu, click on 
Add-Ins… and select the box next to 
Solver Add-In and click OK to 

activate the product. If you have 
problems, complete directions for 
installing “Solver” are described in the 
Excel Help menu.  

 
3. Under the File menu, open the 

Techbal.xls spreadsheet from the file 
where you have saved the program.  
You may wish to save this master 
spreadsheet under a subdirectory 
where the original file cannot be 
accidentally deleted. 

 
4. Note that areas in the spreadsheet 

where data may be entered are colored 
grey. Values entered by the user will 
appear in blue text. The other regions in 
the spreadsheet are protected to 
prevent accidental deletions. 

 
5. A demonstration file called “Techbal-

demo.xls” has been provided to show 
how data should be entered in the 
spreadsheet. The information related to 
this example is discussed later in these 
instructions (see bottom of page 5). If 
you have not previously used Techbal, 
you may wish to open this spreadsheet 
first. 

 
Step II - Enter the Flowsheet Connection 
Matrix  
 
1. Select the MATRIX page of the 

spreadsheet by clicking on the 
appropriate tab at the bottom of the 
page.  This is the page where you will 
enter the information that describes 
your particular flowsheet.   

 
2. Enter a description of your circuit in the 

area titled CIRCUIT (Row 6).  
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3. Enter the names of the unit operations 
(nodes) in your flowsheet beneath the 
NODE title bar (Row 9).  You may use 
up to 10 nodes. 

 
4. In the column labeled STREAM, enter 

the names of all of the streams that 
connect the unit operations in your 
flowsheet (Column A).  You may use 
up to 20 different stream names. 

 
5. Within the matrix defined by the nodes 

and streams, enter a –1 or +1 to 
indicate whether each stream exits or 
enters the first unit operation (node).  
The value zero (0) should be entered if 
the stream does not connect to this 
node.  Repeat this procedure for all 
other unit operations (nodes) in the 
flowsheet. 

 
6. After entering all of the information that 

describes your flowsheet, check the far 
right column.  Each stream should now 
be identified as either FEED (stream 
that enters the flowsheet), PRODUCT 
(stream that exits the flowsheet) or 
INTERNAL (stream that remains 
internal to the flowsheet).  If these 
labels do not agree with your flowsheet 
layout, you have incorrectly entered 
some of your data in the matrix area.  
To assist you in finding errors, the two 
rows have been provided at the bottom 
of the matrix area labeled JUNCTION 
and SEPARATOR.  The numerical 
values in these rows tell you how many 
junctions (two streams in – one stream 
out) or separators (one stream in – two 
streams out) are present in your 
flowsheet for each node.  A summary 

of the stream data is also provided at 
the bottom of the page. 

 
Step III – Enter the Experimental Mass 
and Assay Data 
 
1. Select the DATA page of the 

spreadsheet by clicking on the 
appropriate tab at the bottom of the 
page.  This is the page where you will 
enter the numerical data (mass flow 
rates and assays) that describe each 
stream in your flowsheet.   

 
2. Please note that you do not need to re-

enter a description of your circuit in the 
area titled CIRCUIT (Row 6).  This is 
performed automatically. 

 
3. Enter the names of the assays (e.g., 

copper, lead, zinc, ash, Btu/lb, sulfur, 
etc.) you have performed for each 
stream beneath the MEASURED 
VALUES title bar (Row 9).  Note that 
the first entry cell has already been 
reserved for entering MASS.  You may 
use up to 5 assay values to describe 
each stream. 

 
4. Under the cell titled MASS, enter the 

mass flow rates for each stream.  These 
values may be entered as a true flow 
rate (e.g., kg/min, tons/hr, etc.), as a 
measured quantity (e.g., gms, kgs, lbs, 
etc.) or as a relative percentage or 
fraction of the circuit feed.  However, 
all values must be entered under the 
same format. 

 
5. The numerical values for each assay 

must now be entered in the matrix 
beneath the assay names you entered 
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earlier.  Normally, these values must be 
entered either as a relative indicator of 
mass or heat contained in each stream 
(e.g., % Cu, % ash, ppm Pb, Btu/lb, 
etc.).  Note that percent solids is not 
appropriate as an assay value.  Repeat 
this procedure for all streams in the 
flowsheet. 

 
Step IV - Enter the Relative Standard 
Errors 
 
1. Select the ERRORS page of the 

spreadsheet by clicking on the 
appropriate tab at the bottom of the 
page.  This is the page where you will 
enter the relative errors for the 
experimental values pertaining to your 
flowsheet.   

 
2. Once again note that you do not need 

to re-enter a description of your circuit 
in the area titled CIRCUIT (Row 6).  
This is performed automatically. 

 
3. Enter the relative standard deviations 

(reported as percentages) for each 
experimentally measured (or estimated) 
value.  If these values are not known, 
you may normally assume that assays 
were measured with a relative standard 
deviation of 1% and mass flow rates 
with a relative standard deviation of 
10%.  Any mass or assay value that 
was not known when entered on the 
DATA page should have the maximum 
relative standard deviation (i.e., 99%). 

 
Step V - Initiate the Minimization 
Routine 
  

1. Return to the DATA page of the 
spreadsheet by clicking on the 
appropriate tab at the bottom of the 
page.  

 
2. The minimization routine will run more 

quickly if you provide the spreadsheet 
with initial guesses for the various 
experimental values.  To achieve this, 
simply highlight all of the mass and 
assay values, click the right mouse 
button and select “copy”.  Now 
highlight the same area beneath the 
ESTIMATED VALUES title bar 
(located to the right), click the right 
mouse button and select “paste”.  If 
performed correctly, the total weighted 
sum-of-squares (WSSQ) at the right-
bottom corner of the spreadsheet 
should be zero. 

 
3. Now bring down the list of spreadsheet 

tools by selecting the “Tools” menu on 
the master header for the Excel 
spreadsheet.  Under this list, you should 
select the equation solver subroutine by 
clicking the item labeled “Solver”.  If 
you do not see the “Solver” option 
listed, then you probably did not specify 
that this option be loaded when you 
originally installed Excel.  (“Solver” is 
not one of the default programs that is 
automatically loaded when you install 
Excel.)  You should refer to the “Help” 
menu on the master header to obtain a 
step-by-step procedure for installing 
“Solver”. 

 
4. Examine the entry titled SET TARGET 

CELL in the “Solver” dialog box.  This 
value should be listed as $M$30.  This 
is the cell that refers to the total 
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weighted sum-of-squares at the 
bottom-right corner of the spreadsheet. 
 If this cell is not already selected, 
please do so now. 

 
5. Examine the entry titled EQUAL TO in 

the “Solver” dialog box.  The 
minimization option labeled MIN should 
be selected. 

 
6. Examine the entry titled BY 

CHANGING CELLS in the “Solver” 
dialog box.  Use the mouse to highlight 
this row.  The range of cells specified in 
this entry should correspond to the 
matrix of estimated values (mass and 
assays) beneath the ESTIMATED 
VALUES title bar.  All of the values 
that you plan to adjust should be 
highlighted. 

 
7. Examine the entry titled SUBJECT TO 

THE CONSTRAINTS in the “Solver” 
dialog box.  The constraints should be:  
$B$39:$K$44=0.  If this is incorrect, 
click on the ADD or CHANGE button 
and modify the constraint to set cells 
within this range to zero.  These cells 
are hidden on the DATA page, but 
refer to important calculations on the 
WSSQ page.    

 
8. Click on the SOLVE button to begin 

the minimization process.  This may 
take a considerable amount of time 
depending on the size and complexity of 
your flowsheet. 

 
9. Once “Solver” finds a solution, select 

the OK button to accept the solution.  
The best estimates of your mass and 
assay values are now located beneath 

the ESTIMATED VALUES title bar. 
These values represent a consistent and 
unambiguous set of flowsheet data. 

 
Step VI – Evaluate the Minimization 
Results 
 
1. If your data required a significant 

amount of adjustment, then one or more 
of the values in your original data were 
probably unreliable.   

 
2. The amount of adjustment can be 

qualitatively observed by visually 
comparing the your original data 
(MEASURED VALUES) with the 
adjusted values (ESTIMATED 
VALUES).  Alternatively, you may 
examine the calculated relative change 
between the measured and estimated 
values.  These values are provided on 
the ERRORS page under the 
RELATIVE CHANGE IN 
MEASURED VALUE (%) title bar.  A 
small value indicates that little 
adjustment was required, while a large 
value indicates that a large adjustment 
was required.  A zero indicates no 
adjustment occurred.   

 
3. A relative change of less than 10% can 

normally be accepted for data collected 
under typical plant conditions.  Values 
requiring a larger adjustment should be 
examined for reliability. 

 
4. You may wish to see if a better fit can 

be obtained by selecting different 
relative errors for the various streams.  
This is normally a trial-and-error 
approach that requires a significant 
degree of experience. 
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Mass Balance Example 
 
 The utility of the Techbal spreadsheet is 
best illustrated using an actual example. 
Consider the flowsheet shown in Figure 1 
for a combination coal cleaning circuit 
incorporating spirals and froth flotation.  
Field data obtained using the flowsheet are 
summarized in Table 1. 
 
Step I – Load Software 
 
 Activate the Microsoft Excel application 
and load the Techbal spreadsheet.  The 
blank connection matrix page should 
appear.  In order to avoid loosing the 
master copy of the program, you should 
save the spreadsheet under a different file 
name.  Remember that the only areas on the 
spreadsheet where data may be entered are 
colored grey.  Values entered by the user 
will appear in blue text. 
 
Step II - Enter the Flowsheet Connection 
Matrix  
 
 Select the MATRIX page of the 
spreadsheet by clicking on the appropriate 
tab at the bottom of the page.  Enter a 
description of your circuit (Row 6), the 
names of the unit operations (Row 9), and 
the names of all streams that connect the 
operations (Column A). Within the matrix 
defined by the nodes and streams, enter a –
1 or +1 to indicate whether each stream 
exits or enters each unit operation (node). 
The value zero (0) should be entered if the 
stream does not connect to this node.  A 
completed copy of the MATRIX page for 
this example is shown in Figure 2. 
 

 After describing the flowsheet, check 
the far right column.  Each stream should 
now be identified as either FEED (stream 
that enters the flowsheet), PRODUCT 
(stream that exits the flowsheet) or 
INTERNAL (stream that remains internal 
to the flowsheet).  Two rows have been 
provided at the bottom of the matrix area 
labeled JUNCTION and SEPARATOR.  
The numerical values in these rows tell you 
how many junctions (two streams in – one 
stream out) or separators (one stream in – 
two streams out) are present in your 
flowsheet.  For the case shown, there are 
four product (leaving) streams and five 
internal streams in addition to the single feed 
stream.  All of the unit operations (cyclone, 
spiral, screen and flotation cell) are 
correctly identified as separators, while the 
sump is properly identified as a junction.  If 
these labels do not agree with your ciruit 
layout, you have incorrectly entered some 
of your data in the connection matrix area.  
 
Step III – Enter the Experimental Mass 
and Assay Data  
 
 Select the DATA page of the 
spreadsheet by clicking on the appropriate 
tab at the bottom of the page.  Enter the 
names of the assays (e.g., ash and sulfur) 
for each stream (Row 9) as well as the 
numerical values for the assays for each 
stream.  Next, under the cell titled MASS, 
enter the mass flow rates for each stream.  
A completed copy of the DATA page for 
this example is shown in Figure 3. 
 
Step IV - Enter the Relative Standard 
Errors 
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 Select the ERRORS page of the 
spreadsheet by clicking on the appropriate 
tab at the bottom of the page.  Enter the 
relative standard deviations (reported as 
percentages) for each experimentally 
measured (or estimated) value.  If these 
values are not known, you may normally 
assume that assays were measured with a 
relative standard deviation of 1% and mass 
flow rates with a relative standard deviation 
of 10%.  The higher the value, the less 
confidence you have in the measured value. 
 A large error (e.g., 99%) may be entered 
for an unknown value and small error (e.g., 
0.001%) for values you wish to remain 
unchanged. A completed copy of the 
ERROR page for this example is shown in 
Figure 4. 
 
Step V - Initiate the Minimization 
Routine 
  
 Return to the DATA page of the 
spreadsheet by clicking on the appropriate 
tab at the bottom of the page.  The 
minimization routine will run more quickly if 
you provide the spreadsheet with initial 
guesses for the various experimental values. 
 To achieve this, simply highlight all of the 
mass and assay values, click the right 
mouse button and select “copy”.  Now 
highlight the same area beneath the 
ESTIMATED VALUES title bar (located 
to the right), click the right mouse button 
and select “paste”.  If performed correctly, 
the total weighted sum-of-squares (WSSQ) 
at the right-bottom corner of the 
spreadsheet should be equal to zero.  The 
speadsheet should now appear as shown in 
Figure 5. 
 

 Drop down the list of spreadsheet tools 
by selecting the “Tools” menu on the master 
header for the Excel spreadsheet. Select the 
equation solver subroutine by clicking the 
item labeled “Solver”.  The dialog box 
shown in Figure 6 should appear.  Examine 
the entry titled BY CHANGING CELLS.  
Use the mouse to highlight this row.  The 
range of cells specified in this entry should 
correspond to the matrix of estimated 
values (mass and assays) beneath the 
ESTIMATED VALUES title bar.  All of 
the values that you plan to adjust should be 
highlighted.  After selecting the appropriate 
values, click on the SOLVE button to begin 
the minimization process.  After “Solver” 
finds a solution, select the OK button to 
accept the solution.  The best estimates of 
your mass and assay values are now 
located beneath the ESTIMATED 
VALUES title bar.  The spreadsheet should 
now appear as shown in Figure 7.  
 
Step VI – Evaluate the Minimization 
Results 
 
 If your data required a significant 
amount of adjustment, then one or more of 
the values in your original data were 
probably unreliable or collected under 
conditions that were not steady-state.  The 
amount of adjustment can be qualitatively 
observed by examining the calculated 
relative change between the measured and 
estimated values.  These values are 
provided on the ERRORS page under the 
RELATIVE CHANGE IN MEASURED 
VALUE (%) title bar.  A relative change of 
less than 10% can normally be accepted for 
data collected under typical plant 
conditions.  However, the required 
accuracy may vary greatly depending on the 
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intended use of the data.  For the example 
shown, the adjustments were all less than 
about 5%, suggesting that this was a 
relatively reliable data set. 
 
 You may wish to see if a better fit can 
be obtained by selecting different relative 
errors for the various streams.  This is 
normally a trial-and-error approach that 
requires considerable experience. 
 
Problems? 

 
 If you have technical questions related 
to the operation or application of the 
Techbal spreadsheet, please contact: 
 
Dr. Gerald (Jerry) H. Luttrell 
Department of Mining & Minerals 
Engineering 
100 Holden Hall 
Virginia Polytechnic Institute & State 
University 
Blacksburg, Virginia  24061 
E-Mail: luttrell@vt.edu 
 
User Information 
 
Techbal may be freely distributed by 
commercial or educational organizations 
provided that the primary calculation 
cells remain unaltered. The authors 
provide no warranty related to the 
correctness or applicability of the 
spreadsheet and assume no liability for 
user decisions that may be based on the 
spreadsheet output. Microsoft Excel is 
a registered trademark of the Microsoft 
Corporation. The use of Excel should 
not imply an endorsement by the author. 



 9 

 

Feed

Cyclone

Froth
    Flotation

Spiral     Flotation
      Reject

    Spiral

        Clean

   Reject

         Coal      Flotation
Screen   Concentrate

Sump

 
 
 

Figure 1.  Example of a typical spiral-flotation coal cleaning circuit. 
 
 

 
 

Table 1.  Field data obtained for the spiral-flotation coal cleaning circuit. 
Stream Rate (tph) Ash (%) Sulfur (%) 

Circuit Feed 
Cyclone Oversize 
Cyclone Undersize 
Spiral Concentrate 

Spiral Reject 
Screen Oversize 
Screen Undersize 

Flotation Feed 
Flotation Concentrate 

Flotation Reject 

149.0 
112.0 
37.0 
83.0 
28.0 
78.0 
4.9 
42.0 
26.0 
15.9 

27.90 
26.10 
33.50 
8.60 
76.20 
7.81 
21.40 
32.20 
8.10 
71.80 

0.89 
0.71 
1.33 
0.56 
1.21 
0.55 
0.71 
1.25 
0.86 
1.71 
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Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA  24061-0258

CIRCUIT: Spiral-Flotation Coal Processing Circuit

Node
Stream Cyclone Spiral Screen Sump Flotation Sum Circuit
Circuit Feed 1 0 0 0 0 1 feed
Cyclone O/S -1 1 0 0 0 0 internal
Cyclone U/S -1 0 0 1 0 0 internal
Spiral Conc 0 -1 1 0 0 0 internal
Spiral Tail 0 -1 0 0 0 -1 product
Screen O/S 0 0 -1 0 0 -1 product
Screen U/S 0 0 -1 1 0 0 internal
Float Feed 0 0 0 -1 1 0 internal
Float Conc 0 0 0 0 -1 -1 product
Float Tail 0 0 0 0 -1 -1 product

Junction 0 0 0 1 0 1
Separator 1 1 1 0 1 4
(1=In,-1=Out,0=No Effect) Number of feed streams: 1 Number of internal streams: 5

Number of product streams: 4 Minimum required samples: 9

TECHBAL - MATERIAL BALANCE SPREADSHEET

 
 

Figure 2.  Completed MATRIX page describing the plant flowsheet. 
 
 

Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA  24061-0258

CIRCUIT: Spiral-Flotation Coal Processing Circuit

Measured Values Estimated Values
Stream Mass Ash % Sulfur % Mass Ash % Sulfur %
Circuit Feed 149.00 27.90 0.89
Cyclone O/S 112.00 26.10 0.71
Cyclone U/S 37.00 33.50 1.33
Spiral Conc 83.00 8.60 0.56
Spiral Tail 28.00 76.20 1.21
Screen O/S 78.00 7.81 0.55
Screen U/S 4.90 21.40 0.71
Float Feed 42.00 32.20 1.25
Float Conc 26.00 8.10 0.86
Float Tail 15.90 71.80 1.71

Total WSSQ: ########

TECHBAL - MATERIAL BALANCE SPREADSHEET

 
Figure 3.  Completed DATA page showing measured mass and assay values. 
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Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA  24061-0258

CIRCUIT: Spiral-Flotation Coal Processing Circuit

Relative Standard Deviations (%) Relative Change in Measured Value (%)
Stream Mass Ash % Sulfur % Mass Ash % Sulfur %
Circuit Feed 10.00 1.00 1.00 -100.00 -100.00 -100.00
Cyclone O/S 10.00 1.00 1.00 -100.00 -100.00 -100.00
Cyclone U/S 10.00 1.00 1.00 -100.00 -100.00 -100.00
Spiral Conc 10.00 1.00 1.00 -100.00 -100.00 -100.00
Spiral Tail 10.00 1.00 1.00 -100.00 -100.00 -100.00
Screen O/S 10.00 1.00 1.00 -100.00 -100.00 -100.00
Screen U/S 10.00 1.00 1.00 -100.00 -100.00 -100.00
Float Feed 10.00 1.00 1.00 -100.00 -100.00 -100.00
Float Conc 10.00 1.00 1.00 -100.00 -100.00 -100.00
Float Tail 10.00 1.00 1.00 -100.00 -100.00 -100.00

Total WSSQ: ########

TECHBAL - MATERIAL BALANCE SPREADSHEET

 
Figure 4.  Completed ERROR page showing estimated relative errors. 

 
 
 

Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA  24061-0258

CIRCUIT: Spiral-Flotation Coal Processing Circuit

Measured Values Estimated Values
Stream Mass Ash % Sulfur % Mass Ash % Sulfur %
Circuit Feed 149.00 27.90 0.89 149.00 27.90 0.89
Cyclone O/S 112.00 26.10 0.71 112.00 26.10 0.71
Cyclone U/S 37.00 33.50 1.33 37.00 33.50 1.33
Spiral Conc 83.00 8.60 0.56 83.00 8.60 0.56
Spiral Tail 28.00 76.20 1.21 28.00 76.20 1.21
Screen O/S 78.00 7.81 0.55 78.00 7.81 0.55
Screen U/S 4.90 21.40 0.71 4.90 21.40 0.71
Float Feed 42.00 32.20 1.25 42.00 32.20 1.25
Float Conc 26.00 8.10 0.86 26.00 8.10 0.86
Float Tail 15.90 71.80 1.71 15.90 71.80 1.71

Total WSSQ: 0.00

TECHBAL - MATERIAL BALANCE SPREADSHEET

 
Figure 5.  DATA page after cut-and-paste of measured values into estimated cells. 
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Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA  24061-0258

CIRCUIT: Spiral-Flotation Coal Processing Circuit

Measured Values Estimated Values
Stream Mass Ash % Sulfur % Mass Ash % Sulfur %
Circuit Feed 149.00 27.90 0.89 149.00 27.90 0.89
Cyclone O/S 112.00 26.10 0.71 112.00 26.10 0.71
Cyclone U/S 37.00 33.50 1.33 37.00 33.50 1.33
Spiral Conc 83.00 8.60 0.56 83.00 8.60 0.56
Spiral Tail 28.00 76.20 1.21 28.00 76.20 1.21
Screen O/S 78.00 7.81 0.55 78.00 7.81 0.55
Screen U/S 4.90 21.40 0.71 4.90 21.40 0.71
Float Feed 42.00 32.20 1.25 42.00 32.20 1.25
Float Conc 26.00 8.10 0.86 26.00 8.10 0.86
Float Tail 15.90 71.80 1.71 15.90 71.80 1.71

Total WSSQ: 0.00

TECHBAL - MATERIAL BALANCE SPREADSHEET

 
 

Figure 6.  DATA page just prior to starting the Solver search routine. 
 
 
 

Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA  24061-0258

CIRCUIT: Spiral-Flotation Coal Processing Circuit

Measured Values Estimated Values
Stream Mass Ash % Sulfur % Mass Ash % Sulfur %
Circuit Feed 149.00 27.90 0.89 145.11 28.01 0.87
Cyclone O/S 112.00 26.10 0.71 107.28 25.94 0.72
Cyclone U/S 37.00 33.50 1.33 37.83 33.89 1.29
Spiral Conc 83.00 8.60 0.56 79.90 8.65 0.56
Spiral Tail 28.00 76.20 1.21 27.38 76.38 1.21
Screen O/S 78.00 7.81 0.55 74.75 7.77 0.55
Screen U/S 4.90 21.40 0.71 5.14 21.41 0.71
Float Feed 42.00 32.20 1.25 42.98 32.40 1.22
Float Conc 26.00 8.10 0.86 26.24 8.07 0.88
Float Tail 15.90 71.80 1.71 16.73 70.54 1.76

Total WSSQ: 42.09

TECHBAL - MATERIAL BALANCE SPREADSHEET

 
Figure 7.  DATA page after solving for estimated values. 
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Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA  24061-0258

CIRCUIT: Spiral-Flotation Coal Processing Circuit

Relative Standard Deviations (%) Relative Change in Measured Value (%)
Stream Mass Ash % Sulfur % Mass Ash % Sulfur %
Circuit Feed 10.00 1.00 1.00 -2.61 0.41 -1.95
Cyclone O/S 10.00 1.00 1.00 -4.22 -0.61 1.97
Cyclone U/S 10.00 1.00 1.00 2.25 1.17 -2.69
Spiral Conc 10.00 1.00 1.00 -3.74 0.61 -0.20
Spiral Tail 10.00 1.00 1.00 -2.20 0.24 -0.36
Screen O/S 10.00 1.00 1.00 -4.16 -0.45 -0.25
Screen U/S 10.00 1.00 1.00 4.94 0.03 -0.27
Float Feed 10.00 1.00 1.00 2.32 0.61 -2.07
Float Conc 10.00 1.00 1.00 0.93 -0.31 2.42
Float Tail 10.00 1.00 1.00 5.25 -1.76 3.07

Total WSSQ: 42.09
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Figure 8.  ERROR page showing percentage changes between measured and  
                     estimated values. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


